5 software~

Natural fur Windows

Configuration Utility

Version 6.3.8 fur Windows

Februar 2010

Natural



Dieses Dokument gilt fiir Natural ab Version 6.3.8 fiir Windows.

Hierin enthaltene Beschreibungen unterliegen Anderungen und Erginzungen, die in nachfolgenden Release Notes oder Neuausgaben
bekanntgegeben werden.

Copyright © 1992-2010 Software AG, Darmstadt, Deutschland und/oder Software AG USA, Inc., Reston, VA, Vereinigte Staaten von
Amerika, und/oder ihre Lizenzgeber..

Der Name Software AG, webMethods und alle Software AG Produktnamen sind entweder Warenzeichen oder eingetragene Waren-
zeichen der Software AG und/oder der Software AG USA, Inc und/oder ihrer Lizenzgeber. Andere hier erwédhnte Unternehmens- und
Produktnamen kénnen Warenzeichen ihrer jeweiligen Eigentiimer sein.

Die Nutzung dieser Software unterliegt den Lizenzbedingungen der Software AG. Diese Bedingungen sind Bestandteil der Produkt-

dokumentation und befinden sich unter http://documentation.softwareag.com/legal/ und/oder im Wurzelverzeichnis des lizensierten
Produkts.

Diese Software kann Teile von Drittanbieterprodukten enthalten. Die Hinweise zu den Urheberrechten und Lizenzbedingungen der
Drittanbieter entnehmen Sie bitte den "License Texts, Copyright Notices and Disclaimers of Third Party Products". Dieses Dokument



Configuration Utility

ist Bestandteil der Produktdokumentation und befindet sich unter http://documentation.softwareag.com/legal/ und/oder im Wurzel-
verzeichnis des lizensierten Produkts.

Configuration Utility 3






Inhaltsverzeichnis

1 Configuration Utility .......cccoooiiiiiiiiiiiiiiii i, 1
2 Starting and Terminating the Configuration Utility .........c..ccccoiiiiiiiiiii 3
Starting the Configuration Utility ..........cccocciiiiiiiiiiiiiii, 4
Terminating the Configuration Utility ..........cccccoviiiiiiii 4
Performing a Function while Starting the Configuration Utility ...........c.ccccoeein. 5
3 Elements of the Configuration Utility Window ..o, 7
MENU Bar ...coviiiiiiii 8
TOOIDAT ..o 9
TIE oo 9
Parameters .........oooiiiiiiiiiiiic 10
Context MENUS ......ccooiiiiiiiiiiiiiccc 11
Status Bar ......ccoooiiiiii 11
4 Working with the Configuration Utility ...........cccooiiiiii 13
Creating a New Parameter File ............cccccoooiiiiiiiiiie 14
Locating and Changing a Parameter .............cccccocciiiiiiiiiiiiiiiiiii 15
Finding a Parameter .............ccooiiiiiiiiiiiic 16
Saving the Changes ..........ccccoeoiiiiiiiiiiiiiiii e 16
Restoring the Last Saved Version ............ccccocoviiiiiiiiiiiiiic 18
Copying and Pasting a Parameter File ............ccoccooiiiiiiiiiiiiiiice, 18
Renaming a Parameter File ...........cccccooiiiiiiiiiiiiiiiiii 19
Deleting a Parameter File ... 20
Exporting a Parameter File .........ccccocciiiiiiiiiiiiiiii, 20
Importing a Parameter File ... 21
USING HEIP ..o 21
5 Overview of Configuration File Parameters .............ccccoviniiiiiiiiii 23
Global Configuration File ..........cccccoiiiiiiiiiiiiiiiiiicece e 24
Local Configuration File ...........cccccoiiiiiiiiiiiiiiiii 34
6 Overview of Profile Parameters ............cccccoeiuiiiiiiiiiiiiiiiiiiii 37
Database Management ...........ccccociiiiiiiiiiiiiiiiiiiicee e 39
Natural Execution Configuration .............cccocveviiiiiiiiiiiiiiccccc 40
Natural Development ENvironment ..........ccccccocoiviiiiiiiiiiiiiiiiiiiiiiciccecccces 56
Product Configuration ............cccooiiiiiiiiiiiiic 57
CHEN/SEIVET ..ot 58
7 Invoking Natural with an Alternative Parameter File .............ccccocooiiiiiiniinnnnn. 63




vi



1 Configuration Utility

This documentation describes the Configuration Utility which is used to modify global and local
configuration files and to create or modify parameter files.

This documentation is organized under the following headings:

Starting and Terminating the How to start and terminate the Configuration Ultility.
Configuration Utility

Elements of the Configuration Utility |General information on the menu bar, toolbar, parameters,
Window context menus and status bar.

Working with the Configuration Utility | How to locate and change parameters, find parameters, and
save changes. How to create, copy, paste, rename, delete,
export and import parameter files, and how to use help.

Overview of Configuration File Information on the parameters that can be set in the global
Parameters and local configuration files.
Overview of Profile Parameters Information on the profile parameters that can be set in the

parameter files.

Invoking Natural with an Alternative |How to invoke Natural Studio and Natural Runtime with
Parameter File your own customized parameter file.

See also: Profile Parameter Usage in the Operations documentation and Parameter Reference.

This utility is used to set the parameters in a Windows environment. If you are using Natural for
Windows for remote development in conjunction with Natural's Single Point of Development
(SPoD), see also the sections referring to parameter usage in the corresponding platform-specific
Operations documentation.

J Notes:

1. Parameter files are upward-compatible, but not downward-compatible. Once you have created
a parameter file in a higher version of the Configuration Utility and you try to read it with a
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lower version, an error message will be displayed. To be able to read the file, export the file to
the higher version and then import this file to the lower version of the Configuration Utility.

2. Parameter files are not compatible on different platforms. Therefore, it is not possible to copy
them from one platform to another (for example, from Windows to UNIX or OpenVMS). If you
want to use a parameter file on a different platform, export the file and then import this file on
the target platform.
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2 Starting and Terminating the Configuration Utility

= Starting the Configuration ULIIILY ..........ooeeriiii s
= Terminating the Configuration ULIlity .............ooiiiiiiiii e
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Starting and Terminating the Configuration Utility

Starting the Configuration Utility

A Natural folder automatically appears in the Programs folder of the Start menu after Natural
has been installed. It contains the shortcuts for Natural, including the Natural Configuration Uti-
lity and Help. If specified during installation, several shortcuts are also available on your Windows
desktop.

» To start the Configuration Utility

= From the Windows Start menu choose Programs > Software AG Natural n. n> Configuration
Utility.

Or:

Use the following shortcut on your Windows desktop (only available if specified during
installation).

-
A

The Natural Configuration Utility window appears. See Elements of the Configuration Uti-
lity Window for further information.

Terminating the Configuration Utility

When you terminate the Configuration Utility and you have not yet saved your changes, a dialog
appears for each changed file asking whether you want to save now.

» To terminate the Configuration Utility

s  From the File menu, choose Exit.
Or:
Press ALT+F4.
Or:
From the Control menu, choose Close.

Or:
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Starting and Terminating the Configuration Utility

Choose the corresponding standard button at the right of the title bar.

Performing a Function while Starting the Configuration Utility

You can perform several functions automatically when starting the Configuration Utility.

Invoke the properties of the shortcut that is used to start the Configuration Utility. You can then
specify the following functions after natparm.exe in the Target text box.

Function Description

exit Terminates the Configuration Ultility.
import=parameter-file Imports the specified parameter file.
export=parameter-file Exports the specified parameter file.
parm=parameter-file Selects the specified parameter file in the tree.
save Saves a parameter file.
save=new-parameter-file-name |Saves a parameter file under a different name.

Multiple functions can be specified one after the other (see the examples below).

Examples

® Invoke the Configuration Utility and select the specified parameter file in the tree so that it can
be edited immediately:

natparm.exe parm=parameter-file

Invoke the Configuration Utility, select the specified parameter file in the tree, and save it as a
new file with the specified name:

natparm.exe parm=parameter-file save=new-parameter-file-name

Invoke the Configuration Utility, export the specified parameter file and terminate the Configu-
ration Utility:

natparm.exe export=parameter-file exit

Invoke the Configuration Utility, import the specified parameter file and save it under the name
of the imported file:

natparm.exe import=parameter-file save
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3 Elements of the Configuration Utility Window
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Elements of the Configuration Utility Window

When you start the Configuration Utility, the name of the parameter file which is currently active
is shown in the title bar. It is also selected in the tree.

& Natural Configuration Utility - NATPARM
File Edit %iew Help

DEH@ (B2 X 2|7 | ~]
=- Matural Configuration Files -

__ Global Canfiguration File — Matural Configuratiorn Utility |

: - Local Configuration File
[=I- Matural Parameter Files

R AT ARM

Ready l_ l_ l_ e

Menu Bar

The following menus are available:

Menu |Using the commands in this menu, you can ...

File |Manage (for example, create or delete) parameter files and save the change to all parameter and
configuration files.

Edit |Copy and paste parameter files, and search for parameters.

View |Show or hide the toolbar and status bar.

Help |Invoke the online documentation and display information about the Configuration Ultility.

Many commands can also be chosen from a toolbar and/or context menu.
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Elements of the Configuration Utility Window

Toolbar

You can execute the most important functions using a toolbar button. When you move the mouse
pointer over a toolbar, a brief description for the button is shown in the status bar.

The following toolbar buttons are available:

[ Create new parameter file

[ Save selected parameter or configuration file

Gl Saveallfiles

Copy selected parameter file

[ Paste copied parameter file

¥ Delete selected parameter file

* Restore last saved version of selected parameter or configuration file

& Display help

The drop-down list box in the toolbar enables you to search for a specific parameter. See Finding
a Parameter.

» To switch the toolbar display on and off

s From the View menu, choose Toolbar.

A check mark is shown next to this menu command when the toolbar is displayed in the
Configuration Utility window.

Tree

The tree on the left side of the Configuration Utility window contains nodes for two different types
of files:

® Natural Configuration Files

When you expand this node, you can modify global and local configuration files. See Overview
of Configuration File Parameters.
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Elements of the Configuration Utility Window

® Natural Parameter Files
When you expand this node, you can modify the profile parameters of the different parameter

files. See Overview of Profile Parameters.

For information on how to change the parameter assignments and on how to create your own
parameter files, see Working with the Configuration Utility.

Parameters

When you select a node for a category in the tree, the parameters are shown on the right of the
window. In case of a parameter file, the names of the Natural profile parameters are shown in
parenthesis on the right of the window, behind the label of the corresponding control. Example:

Fil|Natural Configuration Utility - NATPARM

Fil=  Edit

Wiew  Help

D@ B2 X 2

R

[

= HATPARM

[#- Database Management

Character Aszighments |

= N:atural Execution Configuration Terminal command character [CF] X -
- Batch Mode
- Buffer Sizes Clear key character [CLEAR] Ifﬁ
28 “haracter Assignments . I—
- Command Execution Decimal character [DC] .
-- Drate Representation Filler character [F] I
-- Device/Repart Assignments I?—
__ Error Handling Help character [HI ‘
" Field Appearance Input aszign character (1] |=
f#l- Lirnits o I—
__ Program Loading and Deletion |nput delimiter character [1D] .
[#- Regional Settings Thouzand separatar character  [THSEPCH] I
[+ Report Parameters
- Steplibs
[+ System Files LI
Ready v
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Elements of the Configuration Utility Window

Context Menus

Context menus provide for selection the commands that are valid in the current context. The
content of a context menu depends on the currently selected node in the Configuration Utility
window.

» To invoke a context menu

1 Select the node for which you want to invoke a context menu.

2 Click the right mouse button.

The context menu appears and you can now choose the required command.

Status Bar

The status bar is the horizontal information line at the bottom of the Configuration Utility window.
It shows short help texts for the commands in the menu bar, toolbar and context menu.

» To switch the status bar display on and off

s From the View menu, choose Status Bar.

A check mark is shown next to this menu command when the status bar is displayed in the
Configuration Utility window.

Configuration Utility "
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Working with the Configuration Utility

Creating @ New Parameter File ...........oiiiiiii e
Locating and Changing @ Parameter ............oiiiiiiiiieiiiii ettt
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SAVING the CRANGES .....eeiiiiie ettt
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Copying and Pasting @ Parameter File ............oouuiiiiiiiiii e
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Deleting @ Parameter File ...........viiiiiii s
EXporting @ Parameter FIle ........oooi i

B [MPOrting @ ParameEter FilE ..........uuuiuiiiiiiieiiiiiiiiiiiiiietee e nnes

= Using Help
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Working with the Configuration Utility

Creating a New Parameter File

You can create your own parameter files and customize them to your requirements. You can then
invoke Natural with one of these parameter files. See Invoking Natural with an Alternative
Parameter File for further information.

Initially, each parameter file that you create contains Natural's default settings.

@

Tip: It is recommended that you create your own parameter file instead of modifying the
default parameter file NATPARM which is delivered with Natural.

» To create a new parameter file

1

]

From the File menu, choose New.

Or:

Choose the following toolbar button:

[

Or:
Press CTRL+N.

A new parameter file with the default name "NEWn" is now shown in the tree. The default
name is selected so that you can immediately enter a new name. Any text you enter automa-
tically deletes the selection.

Enter a name for the new parameter file.

Press ENTER.
Or:
Click any other position in the tree.

The parameters in the new file are set to the default values. You can set all parameters as
required.

Note: You can also create a new parameter file by copying an existing file or by saving an

existing file under a new name.

14
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Working with the Configuration Utility

Locating and Changing a Parameter

You can locate a parameter in different ways:

® If you know in which parameter group and category the parameter can be found, you can expand

the tree and locate the parameter as described below.

= If you do not know the parameter group and category, you can search for the parameter. See

Finding a Parameter.

» To locate and change a parameter

1
2

Expand the node for a global or local configuration file or for a specific parameter file.

For parameter files: expand the node for a parameter group (for example, Natural Execution
Configuration).

Select the category containing the parameter that you want to change (for example, Buffer
Sizes).

The parameters are shown on the right of the window. In the case of a parameter file, the
names of the Natural profile parameters are shown in parenthesis on the right of the window,
behind the label of the corresponding control.

Or:
Expand the node for a category.

Descriptions for the parameters are shown in the tree, below the node. When you select a
description in the tree, all parameters for this group are shown on the right of the window.
For the description that has been selected in the tree, the corresponding parameter is also
selected on the right of the window and can be modified immediately.

Set the parameter to the required value. See Overview of Configuration File Parameters or

Overview of Profile Parameters for further information.

] Notes:

1. The following applies for check boxes: when a check box is selected, the corresponding
parameter is set to "ON"; when a check box is not selected, the corresponding parameter
is set to "OFF".

2. A browse button, which shows three dots, is available for several parameters. When you
choose this button, you can select the required setting(s) in a dialog box.

When a parameter has been changed, an asterisk (¥) appears next to the corresponding node
name in the tree.
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Working with the Configuration Utility

5 Save your changes as described in Saving the Changes.

Finding a Parameter

If you do not know in which category a parameter can be found, you can search for it. The search
is always performed in the currently selected parameter file, global configuration file or local
configuration file.

» To find a parameter

1  Select a node which belongs to the parameter file or configuration file in which you want to
search for the parameter.

2 From the Edit menu, choose Find.
Or:
Press CTRLAF.

When the toolbar is currently not shown, it is automatically activated and the drop-down list
box containing the parameters is opened.

| Note: When the toolbar is already visible, you can simply open the drop-down list box,

without having to use the above command.

3  Select the parameter from the drop-down list box in the toolbar.

| Note: When a configuration file is currently selected, you can select a category (for

example, Printer Profiles which belongs to the global configuration file) from the drop-
down list box.

The category containing the selected parameter is shown on the right of the window.

Saving the Changes

Different save commands are available. An asterisk (*) appears next to each node name in the tree
where a parameter has been changed.

» To save the changes for the selected configuration file or parameter file

1  Select the node for the file that you want to save.

2 From the File menu, choose Save.
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Working with the Configuration Utility

Or:

Choose the following toolbar button:

=
Or:

Press CTRL+S.

» To save a parameter file under a different name

1  Select the node for the parameter file that you want to save under a different name.

2  From the File menu, choose Save As.

A new parameter file with the default name "NEWn" is now shown in the tree. The default
name is selected so that you can immediately enter a new name. Any text you enter deletes

the selection automatically.
3 Enter a name for the new parameter file.

4  Press ENTER.
Or:
Click any other position in the tree.
» To save the changes to all files
s From the File menu, choose Save All.

Or:

Choose the following toolbar button:

Configuration Utility
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Working with the Configuration Utility

Restoring the Last Saved Version

It is possible to discard your changes and return to the last saved version.

» To return to the last saved version of the selected configuration file or parameter file

1  Select the node for the file for which you want to discard your changes.

2 From the File menu, choose Restore Saved.

Or:
Choose the following toolbar button:
P

The settings of the last saved version are restored.

Copying and Pasting a Parameter File

You can also create a new parameter file by copying an existing file and pasting it in the tree.

» To create a new parameter file

1 Select the node for the parameter file that you want to copy.

2 From the Edit menu, choose Copy.

Or:

Choose the following toolbar button:

Or:

Press CTRL+C.

3  From the Edit menu, choose Paste.

Or:

18
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Working with the Configuration Utility

Choose the following toolbar button:

Or:
Press CTRL+V.

A new parameter file with the default name "NEWn" is now shown in the tree. The default
name is selected so that you can immediately enter a new name. Any text you enter automa-
tically deletes the selection.

Enter a name for the new parameter file.

Press ENTER.
Or:
Click any other position in the tree.

You can now set all parameters as required.

Renaming a Parameter File

You can rename the parameter files in the tree.

When you invoke Natural with a parameter file that has been renamed, make sure to changed its
name in the corresponding shortcuts. See Invoking Natural with an Alternative Parameter File
for further information.

» To rename a parameter file

1
2

Select the node for the parameter file that you want to rename.

From the File menu, choose Rename.
Or:
Press p2.

The name is selected so that you can immediately enter a new name. Any text you enter
automatically deletes the selection.

Enter a new name for the parameter file.

Press ENTER.

Or:
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Working with the Configuration Utility

Click any other position in the tree.

Deleting a Parameter File

You can delete the parameter files in the tree.

When you invoke Natural with a parameter file that has been deleted, make sure to adapt the
corresponding shortcuts. See Invoking Natural with an Alternative Parameter File for further
information.

» To delete a parameter file

1  Select the node for the parameter file that you want to delete.

2  From the File menu, choose Delete.

Or:

Choose the following toolbar button:

x

Or:

Press DEL.

Exporting a Parameter File

When you export a parameter file, a text file is generated which contains the values of the current
parameter file. Such a text file can be used on Windows, UNIX and OpenVMS platforms; to use
it there, you have to import it.

» To export a parameter file

1  Select the node for the parameter file that you want to export.

2 From the File menu, choose Export.
The Export dialog box appears. The name of the selected parameter file is proposed as the
file name. The extension of the resulting file is "LST".

3  Optional. Specify another file name. You can also select another folder.

4  Choose the Save button to export the file.
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Working with the Configuration Utility

If you have not selected another folder, the file is stored in the Natural folder which has been
defined for the temporary files. See also Installation Assignments.

Importing a Parameter File

You can import a parameter file which has previously been exported. The import generates a
binary parameter file from the text file with the extension "LST" which has been generated during
the export.

» To import a parameter file

1  From the File menu, choose Import.

The Import dialog box appears.
2 Select the file that is to be imported. The extension of such a file is "LST".
3  Choose the Open button.

When a file with the same name does not yet exist, the imported parameter file is shown in
the tree.

When a file with the same name already exists, you are asked whether you want to overwrite
the existing file. When you choose not to overwrite the existing file, the new file is created
with the name "NEWn".

Using Help

The Help menu provides different ways of accessing help for the Configuration Utility.

» To access the Configuration Utility documentation

s From the Help menu, choose Help Contents.

Or:
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Working with the Configuration Utility

Choose the following toolbar button:

%

» To invoke context-sensitive help

1  Select the node or parameter for which you want to invoke context-sensitive help.

2 From the Help menu, choose Context Help.
Or:

Press Fi1.

» To display information about the Configuration Utility

s From the Help menu, choose About Natural Configuration Utility.

A dialog box appears, displaying information such as the current version number.
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Overview of Configuration File Parameters

This chapter provides information on the parameters that can be set in the global and local confi-
guration files.

Nal:ural Configuration Ukility -

File Edit Yiew Help

DEH@ =R (X 22 | El
=8 Matural Configuration Files
- Global Configuration File
-- Database Management System Assignments
-- Dictionary Server Assignments
-- Prinker Profiles
[ System Files
= Local Configuration File
- Buffer Pool Assignments
- Installation Assignments
[+]- Matural Parameter Files

M atural Configuration Lty |

Ready I_ I_ l_ A

The configuration files should only be modified by an administrator. They should only be changed
with the Configuration Utility.

Global Configuration File

This parameter group contains the following categories:

= Database Management System Assignments
= Dictionary Server Assignments

= Printer Profiles

= System Files

Database Management System Assignments

The parameters which apply to the database management system assignments are arranged on
the following pages:

= DBMS Assignments
= DBMS Tracing
= SQL Assignments
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Overview of Configuration File Parameters

= XML Assignments

DBMS Assignments

A table is shown which is used to define the database ID with which the database is mapped in

the DDM.

When DBMS assignments have already been defined, they are shown in the table.

DBID
The database ID.

] Note: If you are using DDMs where the database ID is set to "0", a separate entry where
the database ID is also set to "0" must exist, with the corresponding database type spe-
cified. This entry is used at compilation time in order to generate the corresponding
database statements into the generated program (GP).

Type

Since the types of all databases which are to be accessed by Natural must be defined in the

global

configuration file, specify one of the following values for each database ID:

Value

Description

ADA

Adabas database server (this is the default).

ADA2

Adabas database server. This database type is provided for use with Adabas as of version 6
on Open Systems and Adabas as of version 8 on mainframes. In particular, it supports Adabas
LA fields, Adabas large object fields and Natural view sizes greater than 64 KB.

See also Adabas Database Management Interfaces ADA and ADA2 in the Programming Guide.

SQL

Any SQL database that can be accessed using Entire Access, which is Software AG's common
interface to various SQL database systems.

XML

Tamino database server.

Important: You must not define a database type for a DBID which has already been
assigned to a system file in the global configuration file (see System Files). If you do so,
an error message will be issued at Natural startup, indicating an inconsistency in the
system file setting and an error when reading the database assignments.

At compilation time, the profile parameter UDB is not used to determine the database type. UDB
is only used at runtime to determine the database type. The database types must be the same
at compilation time and at runtime.

Exception: For compatibility reasons, it is possible to use database type ADA at compilation
time and ADA2 at runtime.
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Parameter

Applies only to databases of the following types:

Type

Description

SQL

If your database type is SQL, specify the string (DBMS parameter) that is to be used to establish
the connection to the database system with which you want to work. See Natural and Entire Access
in the Database Management System Interfaces documentation for further information on how to
access SQL-type database systems.

XML

If your database system is XML (Tamino), enter the URL of the Tamino database including the
name of the collection which is to be accessed in this database. See Natural for Tamino in the
Database Management System Interfaces documentation for further information on how to access
Tamino databases.

DBMS Tracing

The settings for Adabas Trace, SQL Trace and XML Trace are for error diagnostics reasons. They
should only be filled out when requested by Software AG support. Software AG support will
provide valid values in this case.

SQL Assignments

The following tables are provided:

® SQL date/time conversion
This table is used to specify the conversion masks for Entire Access.

As Natural has only one specific time format, you must decide how this format should be
interpreted in the context of SQL database access. There are several possibilities, however, there
is only one possibility per SQL-type DBID which can be specified here.

DBID

Cannot be edited. Entries for the SQL-type databases defined in the DBMS Assignments
table (see above) are automatically provided.

Mask

The value specifies the configuration for Entire Access. It also specifies the format used to
retrieve the SQL information for DATE, TIME and DATETIME into fields of Natural data format
A. The mask should match the RDBMS-specific configuration for the DATE, TIME or DATETIME
character string representation.

Date

This mask (usually a sub-string of the Mask value) specifies the character string representa-
tion into which the fields of Natural data format D are converted during update or retrieval
of SQL DATE columns.

26
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Overview of Configuration File Parameters

Time
This mask (usually a sub-string of the Mask value) specifies the character string representa-
tion into which the fields of Natural data format T are converted during update or retrieval
of SQL TIME or DATETIME columns.

Remark
You can enter your remarks here, for example, to document how the SQL DATE and TIME
character string representation is configured on the database site.

For database systems that support a common data type both for date and for time, the hash
character (#) can be used in the mask to skip non-relevant portions of DATETIME strings. For
example, the following settings of the masks may be appropriate for the Microsoft SQL Server
which supports a common DATETIME data type for date and time values:

Mask = YYYYMMDD HH:I1T:SS
Date = YYYYMMDD
Time = FHHHHEHHHEHH : T1:SS

" SQL authorization
This table is used to specify user IDs and passwords for an automatic login to an SQL database.

DBID
Cannot be edited. Entries for the SQL-type databases defined in the DBMS Assignments
table (see above) are automatically provided.

Auto Login
When the check box in this column is selected, a non-interactive login is performed to the
database by using the values from this table row. Furthermore, the evaluations of the envi-
ronment variables SQL_DATABASE_LOGIN, SQL_DATABASE_USER, SQL_DATABASE_PASSWORD,
SQL_O0S_USER and SQL_0S_PASSWORD are suppressed.

Type

To define the kind of authentication to be performed for this DBID, specify one of the follo-
wing values:

Value  |Description

DB Database authentication.

(01 Operating system authentication.

DB_OS |Both, database authentication and operating system authentication.

Please note that it depends on the database system which kind of authentication is available.
Furthermore, there are restrictions concerning operating system authentication in Entire
Access. See the Entire Access documentation for a more detailed description.

DB User
The user ID for database authentication.
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DB Password
The password for database authentication.

OS User
The user ID for operating system authentication.

OS Password
The password for operating system authentication.

XML Assignments

A table is shown which is used to specify user IDs and passwords for an automatic login to a
Tamino database.

DBID
Cannot be edited. Entries for the XML-type databases defined in the DBMS Assignments
table (see above) are automatically provided.

Auto Login
When the check box in this column is selected, a non-interactive login is performed to the
database by using the values from this table row. Furthermore, the evaluations of the environ-
ment variables XML_DB_USER, XML_DB_PASSWORD, XML_HTTP_USER and XML_HTTP_PASSWORD are
suppressed.

DB User
The user ID for Tamino database authentication.

DB Password
The password for Tamino database authentication.

HTTP User
The user ID for web server authentication.

HTTP Password
The password for web server authentication.

Dictionary Server Assignments

With dictionary servers, you can access free rules and automatic rules maintained in Predict once
you have access to Predict on a mainframe or UNIX host.

You can assign so-called dictionary servers (a free rule server and an automatic rule server) to one
common logical server name. It is possible to define more than one logical server name where
each name represents a different pair of free rule server and automatic rule server. The servers to
be assigned can be located on different nodes.

In the global configuration file, you define all dictionary servers that are available for selection in
the parameter file. The name of the logical server that is to be used must then be defined in the
parameter file. See Remote Dictionary Access in the Overview of Profile Parameters.
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You can specify the following information:

Name
Specify the name for a logical dictionary server. You can then specify the required information
for the free rule server and automatic rule server in the corresponding text boxes (see below).

When you select the name of a previously defined a logical dictionary server from this drop-
down list box, the text boxes for the free rule server and automatic rule server show the pre-
viously defined information for this logical dictionary server. You can modify or delete this
assignment.

Free rule server
Specify the server name and node name for the server that is to be used for remote access to
Predict free rules.

Automatic rule server
Specify the server name and node name for the server that is to be used for remote access to
Predict automatic rules.

Printer Profiles

Printer profiles are used for printing additional reports, for hardcopies and for batch output
generation. They recognize particular Natural field attributes and insert the appropriate control
sequences (see below) as defined in the profile.

With the ability to translate Natural field attributes into escape sequences, you can control your
printer in various ways by using the right profile name, and you can use the print features of a
given device by using simple attributes in Natural programs.

Each profile that you define can be assigned to a Natural report number either statically by using
the Configuration Utility (see Device/Report Assignments), or dynamically by using the DEFINE
PRINTER statement within a Natural program.

The parameters which apply to the printer profiles are arranged on the following pages:

= Printer Profiles
= TTY Printer Profiles
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= GUI Printer Profiles
Printer Profiles

You can specify the following information:

Name
The name of the printer profile.

Method

You can choose the button in this column to toggle the print method for this printer profile.

Method | Description

TTY |Print data (text files) are sent directly to the spooler ,,as is”. Any printer command sequences
need to be specified explicitly, either dynamically (as program data) or statically (via a printer
profile). As such, the application has full control over the command sequences. This is a low-level
print method that by-passes the printer driver. If you want to use this method, you have to
specify all required information on the TTY Printer Profiles page.

GUI |Report data (page descriptions) are passed to the printer driver which converts the report data
into a spool file, together with any necessary printer control sequences, in the appropriate form
(PostScript, PCL, etc.). This is the normal way of printing under Windows. If you want to use

this method, you have to specify all required information on the GUI Printer Profiles page.

TTY Printer Profiles

You can specify the following information:

Profile name
This drop-down list box contains all TTY-type profile names that have been defined on the
Printer Profiles page. Select the name of the required profile. All information that you specify
on this page, applies to the currently selected profile.

External character set
Optional. An external character set must be defined, for example, if a printer's character set is
different from the system character set, or if you wish to preserve Unicode data by outputting
the data in UTF-8 format.
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You can specify the name of the external character set. If the name is "UTF-8", the data are
converted into UTF-8 format. Otherwise, any name can be used, but it must agree with the
name used in the character translation table definition in the file NATCONV.INI. For example,
if the internal character set name (as defined near the top of the NATCONVINI file) is
"ISO8859_1" and you define "FRED" as the name of the external character set in the printer
profile, a section with the following name must be defined in the file NATCONV.INI, otherwise
no character translation is performed:

[I5S08859_1 -> FRED]

Note that, in the non-UTEF-8 case, the data are first converted from the in-memory format (UTF-
16) into the system code page, prior to any NATCONV.INI-based translation being applied.

For further information on the NATCONV.INI file, see Support of Different Character Sets with
NATCONVINI in the Operations documentation.

Printer control sequences

You can specify whether commands to be triggered at job, page or field level.

Column |Description

Trigger | A triggering event controls the level on which specified printer control sequences are to be
applied. Each row in this scrollable table applies to a specific triggering event:

JOB Use this triggering event if you want your control sequences to apply
to an entire print job. The specified control sequences will represent
the job header and/or job trailer respectively.

PAGE Use this triggering event if you want the control sequences to apply
to each physical output page. The specified control sequences will then
represent the page headers and/or page trailers respectively.

FIELD Use this triggering event if you want the control sequences to apply
to each field (regardless of its AD, CD or PM attributes).

AD and CD These triggering events stand for specific attributes of the session
parameters AD (attribute definition) and CD (color definition). Use these
triggering events if you want the control sequences to be applied at
field level only. Any field in a Natural program with corresponding
attributes will then cause these control sequences to take effect. See
the Parameter Reference for details on these session parameters.

PM=I Use this triggering event if you want the control sequences to apply
to each field with an opposing print direction to that of the page. See
the session parameter PM (print mode) and the terminal command %V
(control of print mode) for more information.

Leading |The leading control sequence is inserted immediately before the triggering event (for example,
to define a job header or to set attributes for field representation).

Trailing | The trailing control sequence is inserted immediately after the triggering event (for example,
to define a job trailer or to reset attributes previously set).
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For each control sequence, you can specify the control characters in either alphanumeric or
hexadecimal format.

) Notes:

1. Blank characters must always be specified in hexadecimal format (*20). If they were entered
directly, they would be confused with the blanks used to delimit tokens in the configuration
file.

2. The escape character must always be specified in hexadecimal format (*1b) because this is
a non-printable character.

Example

This example shows the PCL command for setting a proportional character spacing in both
alphanumeric and hexadecimal format. The escape character "*1b", which must always be
specified in hexadecimal format, corresponds to the decimal value 27.

Alphanumeric format:

AMb(s1P

Hexadecimal format:

AMpr28AT 3731 A0
GUI Printer Profiles

You can specify the following information:

Profile name
This drop-down list box contains all GUI-type profile names that have been defined on the
Printer Profiles page. Select the name of the required profile. All information that you specify
on this page, applies to the currently selected profile.

Margins
The page margins. You can specify (in points) an extra top, bottom, left and/or right page
margin, relative to the top left-hand corner of the printable region.
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Text color

The color to be used. You can select one of the following values:

Value |Description

Leave |Leave the color setting unspecified (a default setting is used).

Ignore|Ignore any color settings (that is, print everything in black).

Retain |Retain any color settings in your Natural program (as specified with the session parameter CD).

Attribute fonts

Fonts are always associated with a particular field representation attribute of the session
parameter AD. You can define a different font for each attribute.

The following options are available:

Option

Description

Display fonts for

Using this drop-down list box, you determine which fonts that are to be shown in
the Font dialog box (which appears when you choose a Set button; see below). If
you select System, only the screen fonts are shown. When you select one of the
printers, any fonts that are installed on this printer are shown in addition to the
screen fonts; this gives you access to more fonts, but has the disadvantage of making
the profile printer-specific.

Fixed fonts only

When this check box is selected, only fixed fonts are shown in the Font dialog box
(which appears when you choose a Set button; see below). When it is not selected,
all fonts (fixed fonts and proportional fonts) are shown in the Font dialog box.

Extra leading You can specify (in points) an extra vertical line spacing in addition to the default
line spacing.
AD When you choose the Set button for an attribute, the Font dialog box appears. This
is a standard Windows dialog in which you can define a font, font style and size.
When a Clear button is enabled, a font has been defined for the corresponding
attribute; you can choose this button to remove the font definition.
System Files

A list of existing Natural system file assignments is shown.

The paths for all possible system files (that is: for all possible DBID/FNR combinations) are defined
in the global configuration file. These must be valid paths which indicate the physical location of
the system files on the disk.

You can specify the following information:

DBID
The database ID.

Configuration Utility
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FNR
The file number.

Alias name
When you specify an alias name for a system file, this name is shown in Natural Studio's
library workspace.

Path
The path to the system file.

The path to each defined system file is then available for selection in the parameter file. See System
Files in the Overview of Profile Parameters.

Local Configuration File

This parameter group contains the following categories:

= Buffer Pool Assignments
= |nstallation Assignments

Buffer Pool Assignments

A table is shown which is used to define buffer pools. See also Natural Buffer Pool in the Operations
documentation.

You can specify the following information:

BP Name
The name of the Natural buffer pool. The name can be up to 8 characters long. The name of
the default buffer pool is NATBP. See also BPID in the Parameter Reference.

@ Caution: Do not delete the default buffer pool NATBP, as it is possible that Natural may

not function properly anymore.

BP Size
The size of the Natural local buffer pool. This setting is used during startup of the Natural
buffer pool by the NATBPSRV server to create a global shared memory segment of the specified
size.

Possible settings: 1 - 512 MB.

Default setting: 1.

Resource Size
The size limit for resources that are loaded into the buffer pool. Resources that exceed this size
are loaded directly from the file system whenever they are accessed by Natural. This option
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prevents the buffer pool from being filled with big resources. If 0 (zero) is specified, all resources
are loaded into the buffer pool regardless of their sizes.

Possible settings: 1 - buffer pool size in KB.

Default setting: 0.

Maximum Users
The maximum number of users that can have simultaneous access to the buffer pool. This

number determines the sizes of some internal tables stored inside the shared memory during
startup.

Possible settings: 1 - 5000.

Default setting: 20.

Directory Entries
The number of directory entries. This value is used by the NATBPSRV server during the start of
the buffer pool. If the maximum value has been reached, this value is automatically increased.

Possible settings: 10 - 9999.

Default setting: 10.

Synchronize

You can choose the button in this column to toggle the setting for the buffer pool synchroniza-
tion.

Setting | Description

Yes |Enable synchronization.

No |Disable synchronization (default).

For further information, see Multiple Buffer Pools in the Operations documentation.

Read Only

When this check box is selected, this is a special buffer pool which only allows read access. In
this case, the value defined for the maximum number of users is ignored.

For further information, see Read-Only Buffer Pool in the Operations documentation.

Alternate BP Name

For a read-only buffer pool, it is possible to define the name of an alternate buffer pool. The
alternate buffer pool must also be a read-only buffer pool.

This text box is only active when the corresponding buffer pool is defined as a read-only buffer
pool. In addition, at least two buffer pools must be defined as read-only buffer pools; otherwise
it is not possible to select an alternate buffer pool from the drop-down list box.
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For further information, see Alternate Buffer Pool in the Operations documentation.
Installation Assignments

You can specify the following:

Path to parameter
The location of the Natural parameter files.

Path to user profiles
The location of the Natural user profiles.

Global configuration file
The name and location of the global configuration file (default name is NATCONF.CFG).

Natural error file directory
The location of the Natural error files.

Natural I/O conversion table
The name of the file which contains the character translation tables used with the internal
character set ISO-8859-1. By default, this file is called NATCONV.INI. See Support of Different
Character Sets with NATCONV.INI in the Operations documentation for further information.

Natural TMP directory
The location of Natural temporary output.

Instead of defining a specific path (for example: c:\ Natural \temp), you can define an environ-
ment variable (for example: Zusertemp%=mytempdir) and embed this variable in the path (for
example: c:\ Natural\ %ousertemp%). At runtime, the path will be used with the currently valid
environment variable (for example: c:\ Natural \mytempdir\).
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This chapter provides information on the profile parameters that can be set in the NATPARM para-
meter file (or an alternative parameter file).

Natural Configuration Utility - NATPARM
File Edit “iew Help

D@ =X 2 7

=~

ERNATFARM
[=]- Database Management

General Parameters
#dabas Specific

[+ User DBMS Assigniment

[+ Bakch Maode

Buffer Sizes

Character Assignments
Command Execution
Date Representation

Error Handling
Field Appearance
Limnikts

Reqgional Settings
Repark Parameters
Skeplibs

Swystem Files
Syskem Variables
[+ Work Files

[+ Compiler Options
Remote Debugging

(=) Product Configuration

Entire System Server

[+ Web IO Interface

[=)- Client/Server

7 DCOM

Remote Dictionary Access
[+ Remate Procedure Call

Ready

Administrator DBMS Assignment

=8 Ngtural Execution Configuration

Device/Report Assignments

Program Loading and Deletion

(=R Ngtural Development Environment

[+ Single Point of Development

[+ Enkire Transackion Propagator

=l

Matural Configuration Ltiliby |

T 4

When you expand the node for a parameter file, nodes for parameter groups are shown.

For a full description of all available profile parameters, see the Parameter Reference.
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Database Management

This parameter group contains the following categories:

= General Parameters

= Adabas Specific

= Administrator DBMS Assignment
= User DBMS Assignment

See also: Database Management System Assignments in the global configuration file.

General Parameters

The following profile parameters apply to the supported database management systems.

Option See the Parameter Reference for a description of this profile
parameter

Database updating DBUPD

Execution of END/BACKOUT TRANSACTION |ET

ET at end of program ETEOP

Adabas Specific

If Natural is used with Adabas, review the following profile parameters and, if necessary, adjust
the default values to meet your specific requirements.

Option See the Parameter Reference for a description of this
profile parameter

Adabas user identification ETID

DB time limit LDB

Multifetch MFSET

Terminate when no ISN found with FIND statement |[RCFIND

Terminate when no ISN found with GET statement |[RCGET

Record hold processing WH
Adabas OPEN/CLOSE processing OPRB
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Administrator DBMS Assignment

The following profile parameters are used to assign administrator-specific database management

system settings.

Option

See the Parameter Reference for a description of this profile parameter

Administrator logical files [LFILE

XA database list XADB

Translation of file number |TF

User DBMS Assignment

The following profile parameters are used to assign user-specific database management system

settings.
Option - . .

See the Parameter Reference for a description of this profile parameter
User database ID UDB

Database for transaction data|ETDB

User logical files LFILE

Natural Execution Configuration

This parameter group contains the following categories:

= Batch Mode

= Buffer Sizes

= Character Assignments

= Command Execution

= Date Representation

= Device/Report Assignments
= Error Handling

= Field Appearance

= | imits

= Program Loading and Deletion
= Regional Settings

= Report Parameters

= Steplibs

= System Files

= System Variables
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= Work Files

Batch Mode

The profile parameters which affect the batch mode behavior of Natural are arranged on the follo-
wing pages:

= Channels
= Appearance
= Frame Characters

See also Natural in Batch Mode in the Operations documentation.

Channels
Option e . .
See the Parameter Reference for a description of this profile parameter
Input data file name CMOBJIN
Input data code page CPOBJIN

Input commands file name [CMSYNIN

Input commands code page|CPSYNIN

Output file name CMPRINT
Output code page CPPRINT
Natural log NATLOG
Enable error processing cC
Appearance
Option e . .
See the Parameter Reference for a description of this profile parameter
Similar output BMSIM
Display input data ECHO

Display session-end message|ENDMSG
Display trailing blanks BMBLANK
Display control characters  [BMCONTROL

Display process time BMTIME
Display window title BMTITLE
Display Natural version BMVERSION
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Frame Characters

Option

See the Parameter Reference for a description of this profile parameter

Frame characters|BMFRAME

Buffer Sizes

Natural uses several buffer areas for the storage of programs and data. You may need to adjust

their sizes in order to achieve maximum buffer efficiency.

Option See the Parameter Reference for a description of this profile parameter
Storage for sort program SORTSIZE

Source area size SSIZE

Work area size USTZE

SAG editor buffer pool size |[EDTBPSIZE

SAG editor logical files EDTLFILES

See also Buffer Pool Assignments in the local configuration file.

Character Assignments

The following profile parameters are used to change default character assignments.

Option

Terminal command character |CF

Clear key character CLEAR
Decimal character DC
Filler character FC
Help character HI
Input assign character IA
Input delimiter character ID

Thousands separator character| THSEPCH

Once a character has been defined to replace a default character, this character cannot be used as

data.
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Command Execution

The following profile parameters are used to control the execution of commands.

Option

See the Parameter Reference for a description of this profile parameter

Enable command mode

CM

Enable terminal command %% and % |ESCAPE

Disable Natural commands NC

Dynamic recataloging

RECAT

Date Representation

The following profile parameters are used to control the representation of dates.

Option See the Parameter Reference for a description of this profile parameter
Date format in output DFOUT

Date format in STACK DFSTACK

Date format in report titles|DFTITLE

Date format DTFORM

Maximum year MAXYEAR

Year sliding window YSLW

Device/Report Assignments

These parameters are used to modify your screen and printer configurations as well as your report

assignments.

Option

See the Parameter Reference for a description of this profile parameter

Override default report number |MAINPR

Devices

See Device Assignments below.

Reports

See Report Assignments below.

See also the profile parameter CMPRTnn which is used for additional reports in batch mode.

Configuration Utility
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Device Assignments

The Devices group shows a scrollable list of configurable logical devices (VIDEO and the logical
printers LPT1 to LPT31) as used in the DEFINE PRINTER statement. The following information can
be changed:

Method

The buttons in this column display the print method used for the corresponding print device.
You can choose a button to toggle the print methods.

Print Method

Description

TTY

This is the raw printing method where the text output by the Natural program is essentially
forwarded to the spooler in unaltered form. Any printer commands must either be output
as data by the Natural program or statically defined in TTY printer profiles. The Windows
printer driver is not used.

GUI

This is the preferred print method under Windows, whereby the output from the Natural
program is passed through the Windows printer driver associated with the specified
printer. Unlike the TTY method, no knowledge of printer commands is required, since
these are automatically inserted by the printer driver.

Close mode

You can select a different close mode for each logical printer. Possible values in the drop-down
list box are:

Close Mode |Description

Auto Printers are automatically closed at the end of a program or when the execution of a called
method is terminated. This is the default setting.

User Closing of printers is controlled by the user. The printer is closed, if one of the following

conditions is met:
® a CLOSE PRINTER statement is executed,
= a DEFINE PRINTER statement is executed,

= the session terminates.

44

Configuration Utility



Overview of Profile Parameters

The following program example describes the user-controlled closing of printers. Note that
the close mode must be first set in the parameter file.

DEFINE DATA
LOCAL
1 #f0UT (A8)
END-DEFINE

*

##OUT := *PROGRAM

*

* Write to report with close mode "user"
WRITE (1) 'OUTPUT PROGRAM: ' #0UT

*

* Write to report with close mode "auto"
WRITE (2) 'OUTPUT PROGRAM: ' #0UT

*

* Close printer 1
* Printer 1 is user-controlled
CLOSE PRINTER (1)

*

END

Line Size
See the description of the LS parameter.

Page Size
See the description of the PS parameter.

Max. Pages
See the description of the MP parameter.

Setup

You can choose a button in this column invoke a print method-specific dialog box:

Print Description
Method

TTY When you choose the Setup button for this print method, the Setup TTY dialog box appears
in which you can specify the following options:

Physical specification
This corresponds to the printer name. Instead of selecting an existing physical printer
specification from the drop-down list box, you can also enter a file name if you want
your output to be written to a file.

Anmerkung: A server printer can be specified via the UNC naming convention

(\ \server-name\ printer-name).
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Print Description
Method
Print to file
Using this check box, you can specify whether file I/O is to be used to access the specified
device (e.g. for printers which are set up as file system shares). If this check box is not
selected, the data is output via spooler API function calls.
GUI

When you choose the Setup button for this print method, the standard Windows Print Setup
dialog box appears and you can select the Windows printer and associated print options
such as page size and orientation.

Anmerkung: If you wish to make use of the default Windows printer on each client computer

at run-time, this dialog should not be used. Alternatively, if a specific printer has already
been chosen (even in a previous session) for this logical device, the default printer can be
implicitly re-selected by switching the print method to TTY, closing the application, re-opening
the application and switching the print method back to GUI. Note that any print options for
the default printer must be set by using a printer profile.

Note: The following applies to the print method TTY if the Print to file check box has been

activated. As with work files, a file name can be defined by using environment variables.
Any existing file of the same name at the specified location is normally overwritten, unless
the entered file name is immediately prefixed by two right angle bracket characters (>>).

Report Assignments

The Reports group shows a scrollable list in which you can assign a Natural report number (report
1 to report 31) to a logical device name. The following information can be changed:

Device

For each report number, you can select another output medium. Possible values in the drop-
down list box are:

Value

Description

LPT1 to LPT31|Outputs the report data to the corresponding physical device.

SOURCE Outputs the report data to the source area. The user can then, for example, issue the
EDIT command to open the output data in the editor and save it accordingly.

DUMMY Report data are discarded.

INFOLINE Report data are sent to the infoline. See also the description of the terminal command

BX.

Report 0 is always implicitly assigned to VIDEO (that is, the output is shown on the screen). No
other report number can be assigned to VIDEO.
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Profile

In addition to the name of the logical device, you can assign a printer profile that has been
defined in the Printer Profiles node of the global configuration file. All defined printer profiles
can be selected from the drop-down list box. Select the blank entry if you do not want to use

any of these profiles.

A\  Important: Any specified printer profile must match the print method used at run-time.

For example, if an attempt is made to use a GUI printer profile for a TTY logical device
(or vice versa), the printer profile specification is ignored.

Error Handling

The following profile parameters are used to control error handling within Natural.

Option

See the Parameter Reference for a description of this profile parameter

Error processing for PA/PF keys

IKEY

Display system error messages in full [MSGSF

Automatic REINPUT REINP
Sound terminal alarm SA
Sound bell on syntax error SNAT
Zero division ZD

Suppress message number prefix NAT [NOAPPLERR

Allow runtime interrupt

RTINT

Field Appearance

The following profile parameters influence I/O handling.

Option See the Parameter Reference for a description of this profile parameter
Control variable modified at input | CYMIN

Filler chars protected FCDP

Enable lowercase LC

Overwriting protected 0PF

Zero printing ZP

Print mode PM

Configuration Utility
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Limits

The following profile parameters are used to prevent a single program from consuming an

excessive amount of internal resources.

Option

P See the Parameter Reference for a description of this profile parameter
Error on loop limit LE
Processing loop limit LT

Maximum number of DBMS calls [MADIO

Maximum number of program calls [MAXCL

System time delay SD

Program Loading and Deletion

The following profile parameters are used to control the dynamic loading and deletion of programs.

Option

See the Parameter Reference for a description of this
profile parameter

Dynamic loading of non-Natural programs CDYNAM
Allow dynamic parameter DYNPARM
Release GDA in utility mode FREEGDA
Persistent parameter module PERSIST
Read only access to system files ROSY
Buffer pool search first BPSFI
Error transaction program name ETA
Program command line parameter PRGPAR

Program to receive control after Natural termination

PROGRAM

Natural stack command line

STACK
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Regional Settings

The following profile parameters are used to control the country- or region-specific settings of
Natural.

Option
P See the Parameter Reference for a description of this profile parameter
Day differential DD
Time differential D
User language ULANG

Use UTF-8 format for sources|SUTF8

Retain source format SRETAIN

Code page conversion error |CPCVERR

Default code page CP
Substitution character SUBCHAR
Report Parameters

The following profile parameters are used to control various attributes of Natural reports.

Option See the Parameter Reference for a description of this profile parameter
Page eject EJ

Numeric edit mask free mode|EMFM

Line size LS

Page size PS

Spacing factor SF

Default input terminal mode |IM

Steplibs

The following parameters are used to manage the steplibs.

Opti
pRen See the Parameter Reference for a description of this profile parameter

*STEPLIB STEPLIB

Steplib Extension |For information on how to define additional steplibs and how to use the columns in
this table, see Additional Steplib Assignments below.
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Additional Steplib Assignments

You can define up to eight libraries that can be searched for objects which cannot be found in the
current library. These additional steplibs are defined in a table. The steplib number is shown in
the first column. The following information can be specified:

Name
The name of an existing library.

DBID
The database ID of the file system where the library is located.

FNR
The file number of the file system where the library is located.

Note: The following application programming interfaces are available for handling multiple

steplibs: USR3025N (when Natural Security is not installed) and USR4025N (when Natural
Security is installed).

System Files

The following profile parameters are used to specify the Natural system files. A page is provided
for each parameter, on which you can specify DBID, FNR, path, read only access, password and
cipher for each system file.

Option
. See the Parameter Reference for a description of this profile

parameter

FNAT (Natural system file for system programs) | FNAT

FUSER (Natural system file for user programs) [FUSER

FSEC (Natural Security system file) FSEC
FDIC (Predict system file) FDIC
FDDM (Natural system file for DDMs) FDDM

If you select a path that has already been assigned to another system file, all relevant internal
information of the first assignment is copied automatically to the new assignment.

The physical location of each system file is defined in the global configuration file. See System
Files in the global configuration file.
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System Variables

The following profile parameters are used to adjust Natural system variables for the start of a

Natural session.

Option

See the Parameter Reference for a description of this profile parameter

Automatic logon |[AUTO

Startup library |[INIT-LIB

Startup program [STARTUP

User ID USER

See also the System Variables documentation.

| Note: You can use the command line parameters NATVERS (to specify the Natural version)

and PARM (to specify a specific Natural parameter file) at session startup. These parameters
can only be specified dynamically, therefore, they cannot be modified or viewed within the

Configuration Utility.

Work Files

The following profile parameters can be used to specify work file settings.

Option
P See the Parameter Reference for a description of this profile parameter
Entire Connection local NCF protocol |NCFVERS
Max. work file number WORK
Alternate sort work file names TMPSORTUNIQ
Work file open on first access WFOPFA

Work files

For information on how to define work files and how to use the
columns in this table, see Work File Assignments below.

See also the profile parameter CMWRKnn which applies to batch mode.

See also Work Files in the Operations documentation.

Configuration Utility
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Work File Assignments

The work file assignments are shown in a scrollable list containing work files with the numbers
1 to 32. The work file number is shown in the first column. When a work file name has already
been defined for a work file number, this information (path and name) is shown in the Name

column.

The following information can be changed:

Type

For each work file number, you can select another work file type. Possible values in the drop-
down list box are:

Work File Type

Description

Default

Determines the file type from the extension for upward compatibility.

SAG

Binary format.

ASCII

Text files with records terminated by a carriage return and linefeed (CR/LF).

When you choose the browse button next to this drop-down list box, you can change
the properties for this work file type: a dialog box appears in which you can specify
the following information:

Code page
You can specify the code page that is to be used for writing the work file (ICU code
page name; IANA name recommended). When a code page is not defined here,
the default code page defined with CP is used.

ASCII
compressed

ASCII format where all trailing blanks are removed.

When you choose the browse button next to this drop-down list box, you can change
the properties for this work file type: a dialog box appears in which you can specify
the following information:

Code page
You can specify the code page that is to be used for writing the work file (ICU code
page name; IANA name recommended). When a code page is not defined here,
the default code page defined with CP is used.

Entire
Connection

With this work file type, you can read and write (for example, with the statements READ
WORK FILEand WRITE WORK FILE)directly to a work file in Entire Connection format
on the local disk.

Anmerkung: No transfer to a PC is possible. The Entire Connection terminal is not used

in this process.
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Work File Type

Description

Unformatted

A completely unformatted file. No formatting information is written (neither for fields
nor for records).

When you choose the browse button next to this drop-down list box, you can change
the properties for this work file type: a dialog box appears in which you can specify
the following information:

Code page
You can specify the code page that is to be used for writing the work file (ICU code
page name; IANA name recommended). When a code page is not defined here,
the default code page defined with CP is used.

Portable

Files which can handle dynamic variables exactly and can also be transported (for
example, from a little endian machine to a big endian machine, and vice versa).

CSv

Comma-separated values. Each record is written to one line in the file. By default, a
header is not written. The default character which is used to separate the data fields is
a semicolon (;).

When you choose the browse button next to this drop-down list box, you can change
the properties for this work file type: a dialog box appears in which you can specify
the following information:

Header
When set to "ON", a header with the Natural field names is written to the file.

Separator character
You can select a different separator character. If you require a separator character
which is not listed in the drop-down list box, you can enter it in the text box of the
drop-down list box.

Code page
You can specify the code page that is to be used for writing the work file (ICU code
page name; IANA name recommended). When a code page is not defined here,
the default code page defined with CP is used.

| Note: The browse button next to this drop-down list box is only available for specific

work file types. See the information in the above table.

For information on the work file formats which result from a specific work file type, see Work
File Formats in the Operations documentation.
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Close mode

You can select a different close mode for each work file. Possible values in the drop-down list

box are:

Close Mode | Description

Auto This is the default setting. Work files are automatically closed at the end of a program or
when the execution of the first called method in a method call hierarchy is terminated and
the first called method was called over COM.
If the first called method was called locally (not over COM), the work files are not closed.
Example: Method A (called over COM) invokes method B which in turn invokes method
C. When the execution of method A is terminated, all work files are closed.

User Closing of work files is controlled by the user. The work file is closed, if one of the following

conditions is met:
" 2 CLOSE WORK FILE statement is executed,
" 2 DEFINE WORK FILE statement is executed,

= the session terminates.

The following program example describes the user-controlled closing of work files. Note that
the close mode must be first set in the parameter file.

DEFINE DATA

LOCAL
1 frouT

(A8)

END-DEFINE

*

#fOUT := *PROGRAM

*

* Write to work file with close mode "user

WRITE WORK 1 'OUTPUT PROGRAM: ' #QUT

*

* Write to work file with close mode "auto

WRITE WORK 2 'OUTPUT PROGRAM: ' #0UT

*

* Close work file 1
* Work file 1 is user-controlled
CLOSE WORK FILE 1

*

END
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Attributes

You can define different attributes for each work file. You can specify one attribute for each
of the following categories:

Category Possible Default Description
Attributes Attribute

Append mode [NOAPPEND or |NOAPPEND |Decides whether new data overwrites the current data
APPEND in the work file or whether new data is appended at the
end of the current data.

Keep/delete KEEP or KEEP Decides whether the work file is kept after closing it or
work file after |DELETE whether it is deleted.
close

Write byte order |[BOM or NOBOM |NOBOM Decides whether a byte order mark is written in front of
mark (BOM) the work file data.

Only available for the work file types which write code
page data: ASCII, ASCII compressed, Unformatted and
CSV. For these work file types, the attribute BOM can only
be set, if the code page UTEF-8 is defined for the work file
(see the description of the Type column).

If a work file of another type is written or a code page
other than UTF-8 is defined, the specification of the
attribute BOM is ignored during runtime.

See also Work Files and Print Files on Windows, UNIX and
OpenVMS Platforms in the Unicode and Code Page Support
documentation.

When you choose the browse button next to this text box, you can set these attributes in a
dialog box. You can also set them in the table as described below.

You can enter a unique abbreviation for each attribute. The delimiter character can be one of
the following: blank, commay(,) or semicolon (;). Example: "a, d" which stands for APPEND and
DELETE.

You can only specify one attribute for each category. You can specify them in any sequence.
When no attributes are specified in the table, the default values are used. You can also check
the current values by invoking the dialog box.

Name
Specity the location (path and name) of the work file.

You can also choose the browse button next to this text box to select the work file from a dialog
box.

See also Defining Work File Names with Environment Variables in the Operations documentation.
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Natural Development Environment

This parameter group contains the following categories:

= Compiler Options
= Remote Debugging
= Single Point of Development

Compiler Options

The following profile parameters are used to set options for the Natural compiler.

Option

See the Parameter Reference for a description of this profile
parameter

Interpretation of database field short names |DBSHORT

Dump generation DU
Length/format specification FS
Keyword checking KCHECK
Structured mode SM
Generate symbol tables SYMGEN
Syntax error control SYNERR
Dynamic thousands separator THSEP
Translate quotation marks TOMARK

MASK compatible with MOVE EDITED MASKCME

Parameter checking for CALLNAT statement |PCHECK

Internal sign representation of format P PSIGNF
Endian mode ENDIAN
Generation of global format identifiers GFID
Active cross reference XREF

See also Compiler Options in the section Using Session Parameters of the Using Natural Studio docu-

mentation and the description of the system command COMPOPT.
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Remote Debugging

The following profile parameters are used to allow for remote debugging.

Option
. See the Parameter Reference for a description of this profile parameter

Remote debugging|RDACTIVE
Node name RDNODE
Port number RDPORT

See also the Debugger documentation.

Single Point of Development

The following profile parameter is used in a remote development environment. It is only relevant
if you intend to use the old Natural debugger in conjunction with an earlier version (NDV2.1) of
the Natural Development Server.

Option
. See the Parameter Reference for a description of this profile parameter

Debugging port| SPODDEBUGPORT

Product Configuration

This parameter group contains the following categories:

= Entire Transaction Propagator
= Entire System Server
= Web I/O Interface
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Entire Transaction Propagator

The following profile parameters are used in conjunction with Software AG's Entire Transaction

Propagator.

Option

See the Parameter Reference for a description of this profile parameter

ETP database list ETPDB

Size of ETP work area|ETPSIZE

Entire System Server

The following profile parameter is used in conjunction with Software AG's Entire System Server

Interface.
Option - . .

See the Parameter Reference for a description of this profile parameter
ESX database |ESXDB

Web 1/O Interface

The following profile parameter is used for Unicode support with the Natural Web I/O Interface.

Option

See the Parameter Reference for a description of this profile parameter

Web 1/0O Interface [WEBIO

Client/Server

This parameter group contains the following categories:

= DCOM
= Remote Dictionary Access

58

Configuration Utility



Overview of Profile Parameters

= Remote Procedure Call

DCOM

The following profile parameters are used to provide DCOM support.

Option
Y See the Parameter Reference for a description of this profile parameter
Server name COMSERVERID
Activation policy ACTPOLICY
Automatic update of registry [AUTOREGISTER

Remote Dictionary Access

The following profile parameters are used for remote dictionary access.

Option
P See the Parameter Reference for a description of this profile parameter

Name of logical dictionary server|USEDIC

When a logical dictionary server has been defined in the global
configuration file, you can select it from the drop-down list box. See
Dictionary Server Assignments in the global configuration file.

Enable usage of repository USEREP

Remote Procedure Call

The profile parameters which apply to the Natural Remote Procedure Call (RPC) are arranged on
the following pages:

= RPC (General)
= RPC (Client)
= RPC (Server)
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= RPC (RDS)

RPC (General)

These profile parameters apply to both client and server.

Option
P See the Parameter Reference for a description of this profile parameter

Request buffer size [MAXBUFF

ACI version ACIVERS
Code page CPRPC
RPC (Client)

These profile parameters apply to the client only.

Option
. See the Parameter Reference for a description of this profile parameter

Automated remote execution AUTORPC

Retry service on alternative server| TRYALT

Send-buffer compression COMPR
Request timeout TIMEOUT
Default server DFS
Library for service directory RPCSDIR
RPC (Server)

These profile parameters apply to the server only.

Option See the Parameter Reference for a description of this profile parameter
Start session as RPC server SERVER

Logon required for server request| LOGONRQ

Server name SRVNAME

Server node SRVNODE

Server user ID SRVUSER

Server wait time SRVWATIT

Server termination event SRVTERM

Server commit time SRVCMIT

Transport protocol TRANSP
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Option

. See the Parameter Reference for a description of this profile parameter
RPC trace TRACE
RPC (RDS)

This profile parameter applies to the client only.

Option
2 See the Parameter Reference for a description of this profile parameter

Remote directory servers|RDS
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7 Invoking Natural with an Alternative Parameter File

By default, Natural Studio and Natural Runtime are invoked with the parameter file NATPARM.
When you have created your own customized parameter file, you can also invoke Natural Studio
and Natural Runtime with this parameter file.

See also Dynamic Assignment of Parameter Values in the Operations documentation.

» To invoke Natural Studio with an alternative parameter file

= Invoke the properties of the shortcut that is used to start Natural Studio and specify the follo-
wing after natural.exe in the Target text box: PARM=parameter-file. Example:

"C:\Program Files\Software AG\Natural\version-number\bin\natural.exe" PARM=myparm

» To invoke Natural Runtime with an alternative parameter file

»  Invoke the properties of the shortcut that is used to start Natural Runtime and specify the
following after naturalr.exe in the Target text box: PARM=parameter-file. Example:

"C:\Program Files\Software AG\Natural\version-number\bin\naturalr.exe" PARM=myparm
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